So far, every drawing you have done has been composed of lines and circles. In this chapter, you learn a third major entity, the ARC. In addition, you expand your ability to manipulate objects on the screen. You learn to rotate objects and create their mirror images. You learn to save Plot settings as named Page setups. First, however, we pick up where we left off in Chapter 4 by showing you how to create polar arrays.

**TASKS**

5.1 Creating Polar Arrays
5.2 Drawing Arcs
5.3 Using the ROTATE Command
5.4 Using Polar Tracking at Any Angle
5.5 Creating Mirror Images of Objects on the Screen
5.6 Creating Page Setups
5.7 Review Material

5.8 WWW Exercise 5 (Optional)
5.9 Drawing 5-1: Flanged Bushing
5.10 Drawing 5-2: Guide
5.11 Drawing 5-3: Dials
5.12 Drawing 5-4: Alignment Wheel
5.13 Drawing 5-5: Hearth
5.14 Drawing 5-6: Slotted Flange
Chapter 5 Arcs and Polar Arrays

5.1 Creating Polar Arrays

**GENERAL PROCEDURE**

1. Select the Array tool from the Modify toolbar or Array from the Modify menu.
2. Define a selection set. (Steps 1 and 2 can be reversed if noun/verb editing is enabled.)
3. Right-click to end selection.
4. Click Polar Array in the dialog box.
5. Pick a center point.
6. Enter the number of items to be in the array.
7. Enter the angle to fill (or 0).
8. Enter the angle between items.
9. Indicate whether to rotate items.

The procedure for creating polar arrays is lengthy and requires some explanation. The first three steps are the same as in rectangular arrays. Step 4 is also the same, except that you select Polar instead of Rectangular. From that point on, the steps are new. First, you pick a center point, and then you have several options for defining the array.

There are three qualities that define a polar array, but two are sufficient. A polar array is defined by any combination of two of the following: a certain number of items, an angle that these items span, and an angle between each item and the next. You also have to tell AutoCAD whether to rotate the newly created objects as they are copied.

- Begin a new drawing using the 1B template.
- In preparation for this exercise, draw a vertical 1.00 line at the bottom center of the screen, near (9.00,2.00), as shown in Figure 5-1.

![Figure 5-1](image)

We use a 360-degree polar array to create Figure 5-2.

- Select the line.
Type Ar, select Array from the Modify menu, or select the Array tool from the Modify toolbar, as illustrated in Figure 5-3.

This opens the Array dialog box, familiar from the last chapter.

Click Polar Array.

Clicking Polar Array changes the dialog box, as illustrated in Figure 5-4.

To define a polar array, you need to specify a center point. Rectangular arrays are not determined by a center. Polar arrays, however, are built by copying objects around the circumferences of circles or arcs, so we need to define one of these.

Below the Polar Array button is a line labeled Center point. There are two edit boxes with the x- and y-coordinates of a default center point, and a Pick Center Point button on the right that takes you out of the dialog box so that you can pick a point.

Click the Pick Center Point button.

Pick a point directly above the line and somewhat below the center of the screen.

Something in the neighborhood of (9.00,5.00) will do. As soon as you pick the point, the dialog box returns with the coordinates of the point entered in the X and Y edit boxes.

Below the Center point edit boxes is a list box labeled Method. If you open this list, you can see the three possible paired combinations of total number of items, angle to fill, and angle between items. We take these in order:

If necessary, select Total number of items & Angle to fill.
With this selection, notice that the Angle between items edit box below is grayed out (unavailable).

✦ Type 12 in the Total number of items edit box.

This time around we construct a complete 360-degree array. This is the default, but if it has been changed you might need to enter it on your computer.

✦ If necessary, enter 360 in the Angle to fill edit box.

Notice the Tip, which tells us that if we give a positive value for angle to fill, the array is constructed counterclockwise; if we give a negative angle, it is constructed clockwise. Get used to this; it comes up frequently.

AutoCAD now has everything it needs. Notice the check box at the bottom left of the dialog box labeled Rotate items as copied. With this box checked, as it should be by default, copied objects in the array are rotated around the center point rather than retaining their vertical/horizontal orientation.

✦ If necessary, check the Rotate items as copied check box.

✦ Click Preview.

Your screen should resemble Figure 5-2, except that there will be a message box with the options Accept, Modify, or Cancel. Click Modify so that we can return to the dialog box and try some other arrangements.

✦ Click Modify.

We use the same center point, but define an array that has 20 items placed 15 degrees apart and not rotated.
Open the Method list and select Total number of items & Angle between items.

Notice that the Angle to fill edit box is now grayed out and the Angle between items box has become accessible.

Type 20 for the number of items.

Type 15 for the angle between items.

All that remains is to tell AutoCAD not to rotate the lines as they are copied.

Clear the Rotate items as copied check box.

Notice how the general preview image at the right of the dialog box changes as you change your selections.

Click Preview to view a true preview.

Your screen should now resemble Figure 5-5.

Click Modify to return to the dialog box.

Try one more and then you are on your own with polar arrays. For this one, define an array that fills 270 degrees moving clockwise and has 30 degrees between each angle, as shown in Figure 5-5:

Open the Method list and select Angle to fill & Angle between items.

Type –270 for the angle to fill.

What does the negative angle do?

Type 30 for the angle in between.

Select the check box to rotate items as they are copied.

Click Preview.

Your screen should resemble Figure 5-6.

Click Accept to close the dialog box and return to the command prompt.

This ends our discussion of polar arrays. With the options AutoCAD gives you, there are many possibilities that you can try. As always, we encourage experimentation. When you are satisfied, erase everything on the screen in preparation for learning the ARC command.
Chapter 5 Arcs and Polar Arrays

5.2 Drawing Arcs

GENERAL PROCEDURE

1. Type a, select the Arc tool from the Draw toolbar, or select Arc from the Draw menu.
2. Type or show where to start the arc, where to end it, and what circle it is a portion of, using any of the 11 available methods.

Learning AutoCAD’s ARC command is an exercise in geometry. In this section, we give you a firm foundation for understanding and drawing arcs so that you are not confused by all the available options. The information we give you is more than enough to do the drawings in this chapter and most drawings you encounter elsewhere. Refer to the AutoCAD Command Reference and the chart at the end of this section (Figure 5-9) if you need additional information.

AutoCAD gives you eight distinct ways to draw arcs (11 if you count variations in order). With so many choices, some generalizations are helpful.

First, notice that every option requires you to specify three pieces of information: where to begin the arc, where to end it, and what circle it is theoretically a part of. To get a handle on the range of options, look at the list of options from the Arc submenu.

- Erase any objects left on your screen from the previous section.
- Open the Draw menu and highlight Arc to open the cascading submenu illustrated in Figure 5-7.

Notice that the options in the fourth panel (Center, Start, End, etc.) are simply reordered versions of those in the second panel (Start, Center, End, etc.). This is how we end up with 11 options instead of eight.

More importantly, Start is always included. In every option, a starting point must be specified, although it does not have to be the first point given.

The options arise from the different ways you can specify the end and the circle from which the arc is cut. The end can be shown as an actual point (all End options) or inferred from a specified angle or length of chord (all Angle and Length options).

The circle that the arc is part of can be specified directly by its center point (all Center options) or inferred from other information, such as a radius length (Radius...
options), an angle between two given points (Angle options), or a tangent direction (the Start, End, Direction, and Continue options).

With this framework in mind, we begin by drawing an arc using the simplest method, which is also the default, the three-points option. The geometric key to this method is that any three points not on the same line determine a circle or an arc of a circle. AutoCAD uses this in the CIRCLE command (the 3P option) as well as in the ARC command.

Select 3 points from the Draw menu, type a, or select the Arc tool from the Draw toolbar, as shown in Figure 5-8.

Figure 5-7

Figure 5-8
AutoCAD’s response is this prompt:

Specify start point of arc or [Center]:

Accepting the default by specifying a point leaves open all those options in
which the start point is specified first.
If you instead type c, AutoCAD prompts for a center point and follows with
those options that begin with a center.
Select a starting point near the center of the screen.

AutoCAD prompts

Specify second point of arc or [Center/End]:

We continue to follow the default three-point sequence by specifying a sec-
ond point. You might want to refer to the chart (Figure 5-9) as you draw this arc.

<table>
<thead>
<tr>
<th>TYPE</th>
<th>APPEARANCE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-point</td>
<td><img src="chart.png" alt="Diagram" /></td>
<td>Clockwise or counterclockwise</td>
</tr>
<tr>
<td>S, C, E (start, center, end)</td>
<td><img src="chart.png" alt="Diagram" /></td>
<td>Counterclockwise</td>
</tr>
<tr>
<td></td>
<td>Start</td>
<td>Radial rubber band indicates angle only, length is</td>
</tr>
<tr>
<td></td>
<td>2nd point</td>
<td>insignificant</td>
</tr>
<tr>
<td></td>
<td>1st point</td>
<td>+ angle = CCW</td>
</tr>
<tr>
<td></td>
<td>End</td>
<td>- angle = CW</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>Rubber band shows angle only, starting from</td>
</tr>
<tr>
<td></td>
<td></td>
<td>horizontal</td>
</tr>
<tr>
<td>S, C, A (start, center, angle)</td>
<td><img src="chart.png" alt="Diagram" /></td>
<td>Counterclockwise</td>
</tr>
<tr>
<td></td>
<td>Start</td>
<td>&quot;Chord&quot; rubber band shows length of chord only,</td>
</tr>
<tr>
<td></td>
<td>45°</td>
<td>direction is insignificant</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>+ angle = CCW</td>
</tr>
<tr>
<td></td>
<td>45°</td>
<td>- angle = CW</td>
</tr>
<tr>
<td></td>
<td>E</td>
<td>Rubber band shows angle only, starting from</td>
</tr>
<tr>
<td></td>
<td></td>
<td>horizontal</td>
</tr>
<tr>
<td>S, C, L (start, center, length of chord)</td>
<td><img src="chart.png" alt="Diagram" /></td>
<td>Counterclockwise</td>
</tr>
<tr>
<td></td>
<td>Start</td>
<td>+ radius = minor arc</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>- radius = major arc</td>
</tr>
<tr>
<td></td>
<td>Length of chord</td>
<td>Rubber band shows + radius values only,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For − radius (type value)</td>
</tr>
<tr>
<td>S, E, A (start, end, angle)</td>
<td><img src="chart.png" alt="Diagram" /></td>
<td>Direction of rubber band is a line tangent to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the arc being constructed and runs through the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>start point</td>
</tr>
<tr>
<td>S, E, R (start, end, radius)</td>
<td><img src="chart.png" alt="Diagram" /></td>
<td>Arc begins at end point</td>
</tr>
<tr>
<td></td>
<td></td>
<td>of previous line or arc</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and is tangent to it; Rubber band is a chord</td>
</tr>
<tr>
<td></td>
<td></td>
<td>from start point to end point</td>
</tr>
</tbody>
</table>

**Figure 5-9**
Select any point one or two units away from the previous point. Exact coordinates are not important right now.

Once AutoCAD has two points, it gives you an arc to drag. By moving the cursor slowly in a circle and in and out, you can see the range of what the third point will produce.

AutoCAD also knows now that you have to provide an endpoint to complete the arc, so the prompt has only one option:

Specify end point of arc:

Any point you select will do, as long as it produces an arc that fits on the screen.

Pick an endpoint.

As you can see, three-point arcs are easy to draw. It is much like drawing a line, except that you have to specify three points instead of two. In practice, however, you do not always have three points to use this way. This necessitates the broad range of options in the ARC command. The dimensions you are given and the objects already drawn determine what options are useful to you.

Next we create an arc using the start, center, end method, the second option illustrated in Figure 5-9.

Type u to undo the three-point arc.

Type a or select the Arc tool.

Select a point near the center of the screen as a start point.

The prompt that follows is the same as for the three-point option, but we do not use the default this time:

Specify second point of arc or [Center/End]:

Specify the Center option.

Tip: If you choose options from the Draw menu, some steps are automated. If you select Start, Center, End, for example, the c is entered automatically.

Type c or right-click and select Center from the shortcut menu, if necessary.

This tells AutoCAD that we want to specify a center point next, so we see the prompt

Specify center point of arc:

Select any point roughly one to three units away from the start point.

The circle from which the arc is to be cut is now clearly determined. All that is left is to specify how much of the circle to take, which can be done in one of three ways, as the following prompt indicates:

Specify end point of arc or [Angle/chord Length]:

We specify an endpoint by pointing. First, however, move the cursor slowly in a circle and in and out to see how this method works. As before, there is an arc to drag, and now there is a radial direction rubber band as well. If you pick a point anywhere along this rubber band, AutoCAD assumes that you want the point where it crosses the circumference of the circle.
**Note:** Here, as in the polar arrays in this chapter, AutoCAD is building arcs counterclockwise, consistent with its coordinate system.

- Select an endpoint to complete the arc.

We now draw one more arc, using the start, center, angle method, before going on. This method has some peculiarities in the use of the rubber band that are typical of the ARC command and they can be confusing. An example of how the start, center, angle method might look is shown in Figure 5-9.

- Type `u` to undo the last arc.
- Type `a` or select the Arc tool.

AutoCAD asks for a center or start point:

```
Specify start point of arc or [Center]:
```

- Pick a start point near the center of the screen.

AutoCAD prompts:

```
Specify second point of arc or [Center/End]:
```

- Type `c` or right-click and select Center from the shortcut menu.

AutoCAD prompts for a center point:

```
Specify center point of arc:
```

- Pick a center point one to three units below the start point.

AutoCAD prompts, as before:

```
Specify end point of arc or [Angle/chord Length]:
```

- Type `a` or right-click and select Angle from the shortcut menu.

Notice how the shortcut menu changes to show different options available at each step.

You can type an angle specification or show an angle on the screen. Notice that the rubber band now shows an angle only; its length is insignificant. The indicated angle is being measured from the horizontal, but the actual arc begins at the start point and continues counterclockwise, as illustrated in Figure 5-9. The prompt reads:

```
Specify included angle:
```

- Type `45` or show an angle of 45 degrees.

Now that you have tried three of the basic methods for constructing an arc, we strongly suggest that you study the chart in Figure 5-9 and then try the other options. The notes in the right-hand column serve as a guide.

The differences in the use of the rubber band from one option to the next are important. You should understand, for instance, that in some cases the linear rubber band is only significant as a distance indicator; its angle is of no importance and is ignored by AutoCAD. In other cases, it is just the reverse: The length of the rubber band is irrelevant, whereas its angle of rotation is important.

**Tip:** One additional trick you should try as you experiment with arcs is as follows: If you press Enter or the spacebar at the Specify start point
[Center]: prompt, AutoCAD uses the endpoint of the last line or arc you drew as the new starting point and constructs an arc tangent to it. This is the same as the Continue option on the pull-down menu.

This completes the discussion of the ARC command. Constructing arcs can be tricky. Another option that is available and often useful is to draw a complete circle and then use the TRIM or BREAK command to cut out the arc you want. BREAK and TRIM are introduced in the next chapter.

5.3 Using the ROTATE Command

GENERAL PROCEDURE

1. Select Rotate from the Modify menu, or select the Rotate tool from the Modify toolbar.
2. Define the selection set. (Steps 1 and 2 can be reversed if noun/verb selection is enabled.)
3. Pick a base point.
4. Indicate an angle of rotation.

ROTATE is a fairly straightforward command, and it has some uses that might not be immediately apparent. For example, it frequently is easier to draw an object in a horizontal or vertical position and then ROTATE it into position rather than drawing it in a diagonal position.

In addition to the ROTATE command, there is a rotate mode in the grip edit system, which we introduce later in this section.

* In preparation for this exercise, clear your screen and draw a three-point arc using the points (8,4), (11.5,2), and (15,4), as in Figure 5-10.

We begin by rotating the arc to the position shown in Figure 5-11.

* Select the arc.
Type Ro, select Rotate from the Modify menu, or select the Rotate tool from the Modify toolbar, as shown in Figure 5-12.

You are prompted for a base point:

Specify base point:

This is the point around which the object is rotated. The results of the rotation, therefore, are dramatically affected by your choice of base point. Choose a point at the left tip of the arc.

Point to the left tip of the arc.

The prompt that follows looks like this:

Specify rotation angle or [Reference]:

The default method is used to indicate a rotation angle directly. The object is rotated through the angle specified and the original object is deleted.

Move the cursor in a circle and you will see that you have a copy of the object to drag into place visually. If Ortho is on, turn it off to see the complete range of rotation.

Type 90 or point to a rotation of 90 degrees.

The results should resemble Figure 5-11.

Notice that when specifying the rotation angle directly like this, the original orientation of the selected object is taken to be 0 degrees. The rotation is figured counterclockwise from there. However, there might be times when you want to
refer to the coordinate system in specifying rotation. This is the purpose of the Reference option. To use it, you need to specify the present orientation of the object relative to the coordinate system, and then tell AutoCAD the orientation you want it to have after rotation. Look at Figure 5-13. To rotate the arc as shown, you can either indicate a rotation of –45 degrees or tell AutoCAD that it is currently oriented to 90 degrees and you want it rotated to 45 degrees. Try the following method for practice:

1. Repeat the ROTATE command.
2. Select the arc.
3. Right-click to end selection.
4. Choose a base point at the lower tip of the arc.
5. Type r or select Reference from the shortcut menu.
6. AutoCAD prompts for a reference angle:
   Specify the reference angle <0>:
   Type 90.
   AutoCAD prompts
   Specify the new angle:
   Type 45.
   Your arc should now resemble the solid arc in Figure 5-13.

Rotating with Grips

Rotating with grips is simple, and there is a useful option for copying, but your choice of object selection methods is limited, as always, to pointing and windowing. Complete the following steps:

1. Pick the arc.
   The arc is highlighted and grips appear. Notice that these grips are especially designed for arcs.
5.4 Using Polar Tracking at Any Angle

You might have noticed that using Ortho or Polar Tracking to force or snap to the 90-degree, 180-degree, and 270-degree angles in the last exercise would make the process more efficient. With Polar Tracking, you can extend this concept to...
include angular increments other than the standard 90-degree orthogonal angles. This feature combined with the Rotate Copy technique facilitates the creation of rotated copies at regular angles. As an example, we use this process to create Figure 5-15.

To begin this task, Erase or Undo all but one arc on your screen.

Move the arc to the center of your screen.

We are going to rotate and copy this arc as before, but first we set Polar Tracking to track at 30-degree angles. This is done in the Drafting Settings dialog box.

Use F9 or the Snap button to turn Snap off.

Click the Polar button on the status bar so that Polar Tracking is on.

Right-click the same Polar button.

This opens a small shortcut menu with three options: On, Off, and Settings. On and Off are not very useful because you can turn the Polar button on and off more quickly by clicking the button. However, selecting Settings opens the Drafting Settings dialog box with the Polar Tracking tab selected.

Select Settings.

You see the Drafting Settings dialog box as shown in Figure 5-16. This is the same dialog box used to specify Snap and Grid settings, but now the Polar Tracking tab is selected. In the next chapter, we use the third tab, Object Snap.

If you are using AutoCAD default settings, the increment angle is 90 degrees. Otherwise, you see whatever increment was set last in your AutoCAD system.

Open the Increment angle drop-down list.

Notice the standard selections, from 90 at the top to 5 at the bottom. Notice also that you can add custom angles by selecting the Additional angles check box, clicking New, and typing in a new value.

Select 30 from the list.

30 replaces 90 as the current increment angle. We do not use the other two panels yet. The first panel sets the relationship between Object Snap Tracking
Settings and Polar Tracking. This is covered in Chapter 6. The second panel gives you the option of measuring angles from the last line segment drawn instead of measuring from the 0 point of the screen coordinate system (absolute).

✦ With 30 showing as the current increment angle, click OK.
✦ Select the arc.
✦ Click on the grip in the middle of the arc.
✦ Right-click to open the grip shortcut menu.
✦ Select Rotate.
✦ Slowly move the cursor in a wide circle around the selected grip.
   Polar Tracking now tracks and snaps to every 30-degree angular increment.
✦ Right-click to open the shortcut menu again.
✦ Select Copy.
✦ Carefully create a copy at every 30-degree angle until you have created a design similar to Figure 5-15.

![Drafting Settings](image)
5.5 Creating Mirror Images of Objects on the Screen

**GENERAL PROCEDURE**

1. Select Mirror from the Modify menu, or the Mirror tool from the Modify toolbar.
2. Define a selection set. (Steps 1 and 2 can be reversed if noun/verb selection is enabled.)
3. Point to two ends of a mirror line.
4. Indicate whether to delete the original object.

There are two main differences between the command procedures for MIRROR and ROTATE. First, to mirror an object you have to define a mirror line; second, you have an opportunity to indicate whether you want to retain the original object or delete it.

There is also a mirror mode in the grip edit system, which we explore later in this section.

> To begin this exercise, Erase or Undo all but one arc on your screen.
> Turn Snap on.
> Rotate the arc and move it so that you have a bowl-shaped arc placed to the left of the center of your screen, as in Figure 5-17.
> Keep Polar Tracking on to do this exercise.
> Select the arc.
> Type Mi, select Mirror from the Modify menu, or select the Mirror tool from the Modify toolbar, as shown in Figure 5-18.

Now AutoCAD asks you for the first point of a mirror line:

Specify first point of mirror line:

![Figure 5-17](image-url)
A mirror line is just what you would expect; the line serves as the mirror, and all points on your original object are reflected across the line at an equal distance and opposite orientation.

We show a mirror line even with the top of the arc, so that the endpoints of the mirror images are touching.

Select a point even with the left endpoint of the arc, as in Figure 5-19.

You are prompted to show the other endpoint of the mirror line:

Specify second point of mirror line:

The length of the mirror line is not important. All that matters is its orientation. Move the cursor slowly in a circle, and you see an inverted copy of the arc moving with you to show the different mirror images that are possible given the first point you have specified.

Select a point at 0 degrees from the first point, so that the mirror image is directly above the original arc and touching at the endpoints, as in Figure 5-19.

The dragged object disappears until you answer the next prompt, which asks if you want to delete the original object.

Delete source objects [Yes/No]? <N>:

This time around, do not delete the original.

Press Enter to retain the old object.
Your screen should look like Figure 5-19, without the mirror line in the middle.

Now let's repeat the process, deleting the original this time and using a different mirror line.

- Repeat the MIRROR command.
- Select the original (lower) arc.
- Right-click to end selection.

Create a mirror image above the last one by choosing a mirror line slightly above the two arcs, as in Figure 5-20.

- Select a first point of the mirror line slightly above and to the left of the figure.
- Select a second point directly to the right of the first point.
- Type y or right-click and select Yes from the shortcut menu, indicating that you want the source object, the lower arc, deleted.

Your screen should now resemble Figure 5-21.

**Mirroring with Grips**

The Mirror grip edit mode works exactly like the Rotate mode, except that the rubber band shows you a mirror line instead of a rotation angle. The option to retain or delete the original is obtained through the Copy option, just as in the Rotate mode. Try the following:

- Select the two arcs on your screen by pointing or using a crossing window.
  
  The arcs are highlighted and grips are showing.

- Pick any of the grips.

- Right-click and then select Mirror from the shortcut menu.
  
  Move the cursor and observe the dragged mirror images of the arcs. Notice that the rubber band operates as a mirror line, just as in the MIRROR command.
Figure 5-21

- Type b or right-click again and select Base point.
  This frees you from the selected grip and allows you to create a mirror line from any point on the screen. Notice the Specify base point: prompt in the command area.
- Pick a base point slightly below the arcs.
- Type c or right-click and select Copy from the shortcut menu.
  As in the Rotate mode, this is how you retain the original in a grip edit mirroring sequence.
- Pick a second point to the right of the first.
  Your screen should resemble Figure 5-22.
- Press Enter or the spacebar to exit Grip edit mode.

Figure 5-22
5.6 Creating Page Setups

**GENERAL PROCEDURE**

1. Select the Plot tool from the Standard toolbar.
2. Make changes in Plot settings.
3. Click Add to open the Add Page Setup dialog box.
4. Enter a name for the page setup.
5. Click OK.

In this chapter and the next, you move to another level in your exploration of AutoCAD plotting. So far, we have confined ourselves to plot configurations tied directly to objects visible in your model space drawing area. In this chapter, we continue to plot from model space, but introduce the concept and technique of page setups. With page setups, you can name and save different plot configurations so that one drawing can produce several different page setups. We define two simple page setups. You do not need to learn any new options, but you do learn to save settings of the options we have covered so far so that they can be reused as part of a page setup.

To begin this task, you should be in an AutoCAD drawing using the 1B template.

Any drawing will do. We will continue using the objects drawn in Task 5.5.

**The Page Setup Dialog Box**

A page setup is nothing more than a group of plot settings, like the ones you have been specifying since Chapter 2. The only difference is that you give the
configuration a name and save it on a list of setups. Once named, the plot settings can be restored by selecting the name and they can even be exported to other drawings.

You can define a page setup from the Plot dialog box or from the Page Setup dialog box, accessible through the Page Setup Manager on the File menu. There is little difference between the two dialog boxes. Here we continue to use the Plot dialog box.

Select the Plot tool from the Standard toolbar.

You should now be in the familiar Plot dialog box. We make a few changes in parameters and then give this page setup a name.

We create a portrait setup and a landscape setup. Besides the difference in orientation, the only difference in settings between the two is that the portrait setup is centered, whereas the landscape setup is plotted from the origin.

**Note:** Remember that you must have a plotter or a printer selected to do a preview.

- Make sure you have a plotter selected in the Printer/plotter list.
- Open the Paper size list and select an A-size 8.50 × 11.00 sheet.
- Select Limits in the Plot area panel.
- Select Center the Plot in the Plot offset panel.
- Select the Portrait radio button in the Drawing orientation panel.

Notice how the preview image changes. Pause a minute to make sure you understand why the preview looks this way. Assuming you are using the objects drawn in this chapter, or another drawing using the 1B template, you have model space limits set to 18 × 12. You are plotting to an 8.5 × 11 sheet of paper. The 18 × 12 limits have been positioned in portrait orientation, placed across the effective area of the drawing sheet, scaled to fit, and centered on the paper.

Now you name this page setup.

- Click the Add button at the upper right of the dialog box next to the Page setup name box.

This opens the Add Page Setup dialog box shown in Figure 5-24.

![Add Page Setup](image)
Type Portrait as the page setup name.

Click OK.

This brings you back to the Plot dialog box. Portrait is now entered in the Page setup name box. That's all there is to it. The portrait page setup information is now part of the current drawing.

Next, we define a landscape page setup and put it on the list as well. The only difference in this setup is that it is in landscape orientation and plotted from the origin rather than centered.

Select the Landscape radio button in the Drawing Orientation panel.

Notice that Portrait is no longer in the Page setup edit box now that you have changed a parameter.

Clear the check mark on Center the plot.

Notice that the preview image of the page stays in the portrait position even though the plot will be a landscape plot. This is because the sheet size is 8.5 × 11. If you wanted to rotate this image to the horizontal, you would need to select an 11 × 8.5 sheet. So now you have the 18 × 12 limits aligned with the left edge of the page, positioned at the origin of the effective area, and scaled to fit. Let's give this setup a name.

Click Add again.

Type Landscape in the User Defined Page Setups box.

Click OK.

Back in the Plot dialog box, you see that Landscape setup has been entered as the current page setup. You should now restore the portrait settings.

Open the Page setup name drop-down list and select Portrait.

Your portrait settings, including the Portrait radio button and Center the plot, are restored.

Click Preview.

You should see a preview similar to Figure 5-25.

Press Esc to return to the dialog box.

Open the Page setup name drop-down list again and select Landscape.

Your landscape settings are restored.

Click Preview.

You should see a preview similar to Figure 5-26. Notice that AutoCAD turns the paper image to landscape orientation in the full preview.

This is a simple demonstration, but remember that everything from sheet size to the plotter you are using and all the settings in the Plot Configuration dialog box can be included in a named page setup.

**Note:** Once you have defined page setups you can access them through the Page Setup Manager, opened from the File menu. This dialog box is a simple interface that allows you to select page setups from a list. It will then take you to the Page Setup dialog box to modify existing page setups or create new ones. In addition, you can import page setups from other drawings, as described next.
Chapter 5 Arcs and Polar Arrays

Figure 5-25

Figure 5-26
Importing Page Setups

A powerful feature of page setups is that they can be exchanged among drawings using the PSETUPIN command. This allows you to import page setups from a known drawing into the current drawing. The procedure is as follows:

1. From a drawing into which you would like to import a page setup, type psetupin at the command line or open the Page Setup Manager and click Import.
2. In the Select Page Setup From File dialog box, enter the name and path of the drawing file from which you would like to import a page setup, or open the folder containing the file and select it.
3. In the Import Page Setups box, select the name of the page setup you want to import.
4. Enter the Plot or Page Setup dialog box and open the Page setup name list. The imported page setup should be there.

Note: Page setups are defined in either model space or paper space as part of a layout. If you create a page setup in model space and then go into a paper space layout, you will not see it on your list. Also, if you define a page setup as part of a paper space layout, you will not see it if you begin a plot from model space.

5.7 Review Material

Questions

1. What factors define a polar array? How many are needed to define an array?
2. What factors define an arc? How many are needed for any single method?
3. How would you use Polar Tracking instead of Polar Array to create Figure 5-6?
4. What is the difference between the three points option in the CIRCLE command and the three points option in the ARC command?
5. Explain the significance of the rubber band in the Start, Center, Angle and the Start, End, Direction methods.
6. How would you use the reference option to rotate a line from 60 degrees to 90 degrees? How would you accomplish the same rotation without using a reference?
7. What is the purpose of the base point option in the grip edit Rotate mode?
8. Why does MIRROR require a mirror line whereas ROTATE requires only a single point?
9. How do you create a landscape plot if your printer prints in portrait orientation?
10. What would happen if a drawing created with our 1B template were printing with a 1-to-1 scale on an A-size printer? What feature of the Plot Configuration dialog box would you use to find out if you weren't sure?

Drawing Problems

1. Draw an arc starting at (10,6) and passing through (12,6.5) and (14,6).
2. Create a mirrored copy of the arc across the horizontal line passing through (10,6).
3. Rotate the pair of arcs from Step 2 45 degrees around the point (9,6).
4. Create a mirrored copy of the pair of arcs mirrored across a vertical line passing through (9,6).
5. Create mirrored copies of both pairs of arcs mirrored across a horizontal line passing through (9,6).
6. Erase any three of the four pairs of arcs on your screen and re-create them using a polar array.

5.8 WWW Exercise 5 (Optional)

In addition to the self-scoring test, Chapter 5 of our companion website gives you another challenge to draw an object using a limited number of objects and edit commands. We also give you links to two new CAD-related websites. When you are ready, complete the following:

✦ Make sure that you are connected to your Internet service provider.
✦ Type browser or open the Web toolbar and select the Browse Web tool.
✦ If necessary, navigate to our companion website at www.prenhall.com/dixriley.

Bon voyage!
5.9 Drawing 5-1: Flanged Bushing

This drawing makes use of a polar array to draw eight screw holes in a circle. It also reviews the use of layers and linetypes. Please save this drawing, as noted subsequently.

**Drawing Suggestions**

- **GRID** = 0.25  
- **SNAP** = 0.125  
- **LTSCALE** = 0.50  
- **LIMITS** = (0,0)(12,9)

- Draw the concentric circles first, using dimensions from both views. Remember to change layers as needed.
- Once you have drawn the 2.75-diameter bolt circle, use it to locate one of the bolt holes. Any of the circles at a quadrant point (0 degrees, 90 degrees, 180 degrees, or 270 degrees) will do.
- Draw a center line across the bolt hole, and then **ARRAY** the hole and the center line 360 degrees. Be sure to rotate the objects as they are copied; otherwise, you will get strange results from your center lines.

**Save This Drawing**

This drawing is used in Chapter 6 to demonstrate AutoCAD drawing layouts, paper space, and the use of multiple viewports. It is important that you save the drawing so that you can use it to learn these important plotting techniques.
Chapter 5 Arcs and Polar Arrays

FLANGED BUSHING

Drawing 5–1
5.10 Drawing 5-2: Guide

There are six arcs in this drawing, and although some of them could be drawn as fillets, we suggest that you use the ARC command for practice. By drawing arcs, you also avoid a common problem with fillets. Because fillets are designed to round intersections at corners, creating a fillet in the middle of a line erases part of that line unless you turn Trim mode off. This would affect the center line on the left side of the front view of this drawing, for example.

Drawing Suggestions

GRID = 0.25
SNAP = 0.125
LTSCALE = 0.50
LIMITS = (0,0)(12,9)

- The three large arcs in the top view all can be drawn easily using Start, Center, End.
- The smaller 0.375 arc in the top view could be drawn by filleting the top arc with the horizontal line to its right. However, we suggest you try an arc giving Start, Center, End or Start, Center, Angle. Note that you can easily locate the center by moving 0.375 to the right of the endpoint of the upper arc.
- The same method works to draw the 0.25 arc in the front view. Begin by dropping a line down 0.25 from the horizontal line. Start your arc at the end of this line and move 0.25 to the right to locate its center. Then the end is simply 0.25 down from the center (or you could specify an angle of 90 degrees).
- Similarly, the arc at the center line can be drawn from a start point 0.25 up from the horizontal. It has a radius of 0.25 and makes an angle of 90 degrees.
GUIDE
Drawing 5-2
5.11 Drawing 5-3: Dials

This is a relatively simple drawing that gives you some good practice with polar arrays and the ROTATE and COPY commands.

Notice that the needle drawn at the top of the next page is only for reference; the actual drawing includes only the plate and the three dials with their needles.

Drawing Suggestions

GRID = 0.25
SNAP = 0.125
LTSCALE = 0.50
LIMITS = (0,0)(18,12)

- After drawing the outer rectangle and screw holes, draw the leftmost dial, including the needle. Draw a 0.50 vertical line at the top and array it to the left (counterclockwise—a positive angle) and to the right (negative) to create the 11 larger lines on the dial. How many lines in each of these left and right arrays do you need to end up with 11?
- Draw a 0.25 line on top of the 0.50 line at the top of the dial. Then use right and left arrays with a Last selection to create the 40 small markings. How many lines are in each of these two arrays?
- Complete the first dial and then use a multiple copy to produce two more dials at the center and right of your screen. Be sure to use a window to select the entire dial.
- Finally, use the ROTATE command to rotate the needles as indicated on the new dials.
Chapter 5 Arcs and Polar Arrays

DIALS
Drawing 5–3
5.12 Drawing 5-4: Alignment Wheel

This drawing shows a typical use of the MIRROR command. Carefully mirroring sides of the symmetrical front view saves you from duplicating some of your drawing efforts. Notice that you need a small snap setting to draw the vertical lines at the chamfer.

Drawing Suggestions

GRID = 0.25  
SNAP = 0.0625  
LTSCALE = 0.50  
LIMITS = (0,0)(12,9)

- There are numerous ways to use MIRROR in drawing the front view. As the reference shows, there is top-bottom symmetry as well as left-right symmetry. The exercise for you is to choose an efficient mirroring sequence.
- Whatever sequence you use, consider the importance of creating the chamfer and the vertical line at the chamfer before this part of the object is mirrored.
- Once the front view is drawn, the right side view is easy. Remember to change layers for center and hidden lines and to line up the small inner circle with the chamfer.
ALIGNMENT WHEEL

Drawing 5-4
Once you have completed this architectural drawing as it is shown, you might want to experiment with filling in a pattern of firebrick in the center of the hearth. The drawing itself is not complicated, but little errors become very noticeable when you try to make the row of $4 \times 8$ bricks across the bottom fit with the arc of bricks across the top, so work carefully.

**Drawing Suggestions**

- **UNITS** = Architectural
  Precision = 0’ – $01/8$’
- **LIMITS** = (0,0)(12’,9’)
- **GRID** = 1’
- **SNAP** = 1/8”

- Zoom in to draw the wedge-shaped brick indicated by the arrow on the right of the dimensioned drawing. Draw half of the brick only and mirror it across the center line as shown. (Notice that the center line is for reference only.) It is very important that you use MIRROR so that you can erase half of the brick later.
- Array the brick in a 29-item, 180-degree polar array.
- Erase the bottom halves of the end bricks at each end.
- Draw a new horizontal bottom line on each of the two end bricks.
- Draw a $4 \times 8$ brick directly below the half brick at the left end.
- Array the $4 \times 8$ brick in a one-row, nine-column array, with 8.5” between columns.
Chapter 5 Arcs and Polar Arrays

HEARTH
Drawing 5-5
5.14 Drawing 5-6: Slotted Flange

This drawing includes a typical application of polar arrays and arcs. The finished drawing should consist of the 2-D top view and front view, not the 3-D view shown on the drawing page. The center lines and outline of the large circle in the top view are shown in the reference drawing. Use the three-dimensional view as a reference to draw the two-dimensional top and front views.

**Drawing Suggestions**

- Begin by drawing the circles in the top view. Use the circles to line up the vertical lines in the front view.
- The small arcs in the slots can be drawn on a center line and rotated and copied into place using grips.
Chapter 5 Arcs and Polar Arrays

SLOTTED FLANGE
Drawing 5-6